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Notice 
Daikin Applied reserves the right to change any information contained herein without prior notice. The 
user is responsible for determining whether this product is appropriate for his or her application.  
® ™ The following are trademarks or registered trademarks of their respective companies:  Flasher, 
JFlash ARM, J-Link, SEGGER from Segger Microcontroller Systems LLC, United Technologies 
Corporation (UTC); Atmel from Atmel Microprocessor, Inc., Smart ARM Microcontroller (SAM-BA) from 
Atmel, Windows, Windows 2000, Windows 7, and Windows XP from Microsoft Corporation; BACnet 
from ASHRAE; LONWORKS and LONMAKER from Echelon Corporation, MicroTech from Daikin Applied. 

Reference Documents  
Number Company Title Source 

OM 1111 Daikin Applied MicroTech® III Unit Controller for Fan Coil Unit 
Operations Manual www.daikinapplied.com 

IM 1012 Daikin Applied MicroTech III Fan Coil LONWORKS 
Communication Module Installation Manual www.daikinapplied.com 

IM 1013 Daikin Applied MicroTech III Fan Coil BACnet Communication 
Module Installation Manual www.daikinapplied.com 

ED 15135 Daikin Applied MicroTech III Fan Coil Unit Controller Protocol 
Information Manual www.daikinapplied.com 

 

Revision History 
Document Name Date Description 

OM 1095 October 2015 Initial document release. 
 

! WARNING 

Electric shock hazard. Can cause personal injury or equipment damage. 

This equipment must be properly grounded. Only personnel who are knowledgeable in the operation of the 
equipment being controlled must perform connections and service to the unit controller. 

 

! CAUTION 

Static sensitive components. Can cause equipment damage. 

Discharge any static electrical charge by touching the bare metal inside the control panel before 
performing any service work. Never unplug cables or control modules while power is applied to the unit 
controller. 

 
NOTICE 

This equipment generates; uses and can radiate radio frequency energy and, if not installed and used in 
accordance with this instruction manual, may cause interference to radio communications. It has been 
tested and found to comply with the limits for a Class A digital device, pursuant to part 15 of the FCC rules. 
These limits are designed to provide reasonable protection against harmful interference when the 
equipment is operated in a commercial environment. Operation of this equipment in a residential area is 
likely to cause harmful interference in which case the user will be required to correct the interference at his 
or her own expense. Daikin Applied disclaims any liability resulting from any interference or for the 
correction thereof. 
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Introduction   
MicroTech® III fan coil unit controllers ship with the necessary software required for 
unit operation.  However, it may be necessary to install new or updated versions of 
software in the field.  The purpose of this document is to describe how to download 
the software and verify that it has been installed correctly.  This document also 
describes the download and configuration process for auxiliary MicroTech III controls 
options. 
 

Auxiliary controls options include the I/O expansion module and BACnet® or 
LONWORKS® communication modules for network integration.  It is assumed that all 
hardware is properly installed.  Refer to the Reference Documents section for 
installation manual details. 
 

This guide is organized into four main sections.  The first three sections provide 
instructions for updating the specific files associated with each of the following: 
 

1. Fan Coil Unit Controller and I/O Expansion Module 
2. LONWORKS Communication Module 
3. BACnet Communication Module 
 

The fourth section is the Troubleshooting Guide.  This is a helpful reference with tips 
on solving potential hardware and/or software issues, along with detailed descriptions 
of fan coil unit options and associated equipment configuration software jumper 
settings.  

Getting Started 
Before proceeding, please refer to Figure 1 to verify the software numbers and 
corresponding versions.  Note that a “Yes” indicates software compatibility among 
versions of unit controller and auxiliary unit controllers (I/O expansion module and/or 
communication modules).   

Figure 1.Software Compatibility Matrix 

 Fan Coil Unit Controller 
Software 2506905 

Auxiliary Unit controller 
Software Number Version Number 1.0 1.1 

 
I/O Expansion Module 

2506906  
 

1.0 Yes Yes 

LonWorks Module 
2506907  

1.0 Yes Yes 

1.1 Yes Yes 

BACnet Module 
2506908 

1.0 Yes Yes 

1.1 Yes Yes 
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Figure 2.  Fan Coil Unit Controller Software Revision Label 

 
Figure 3. BACnet MS/TP Communication Module Software Revision Label 

       

 

 

 

 

Figure 4. LONWORKS Communication Module Software Revision Label  

 

BACnet software 
version label 

LonWorks software 
version label 

Unit controller software 
version 
labe

l 
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Downloading Unit Controller and I/O Expansion 
Module Software 

Introduction 
The following section describes how to download and verify the MicroTech III fan coil 
unit controller and I/O expansion module using Flasher 5 hardware and Flasher 
software programming tools.   
 

Joint Test Action Group (JTAG) is a common name for the IEEE (Institute of Electrical 
and Electronics Engineers) 1149.1 Standard, which was created for the development 
and testing of embedded interface devices such as the fan coil unit controller. The 
JTAG hardware and software tools referenced in this document are manufactured by 
Segger Microcontroller Systems.  However, there are other manufacturers of JTAG-
supported hardware and corresponding software interface tools that would also be 
acceptable.   

Getting Started 
Hardware and Software Requirements 
You will need the following:  
 Fan coil unit controller and I/O expansion module, if attached 

 The latest version of Flasher 5 (5.05.01 or newer) hardware, available at 
www.segger-us.com/flasherprogrammer.htm 

 Flasher 5 software available at www.segger.com/cms/downloads.html?pid=19 

 Computer with Windows7 or newer operating system.  Refer to www.segger.com 
for compatibility with older versions of Windows 

Fan coil unit controller and I/O expansion module .hex file. Contact the ATS 
Technical Support Team at 315-282-6434 to request a copy of this firmware file. 

Terminology 
 MicroTech III Fan Coil Unit Controller - The baseboard that is attached to the 

fan coil and ships with the most current version of application software for unit 
operation.     

 I/O Expansion Module - Used for secondary fan connections, emergency 
shutdown, economizer, and dehumidification unit control.  The I/O expansion 
module is attached directly to unit controller when these options have been 
selected with the unit. 

 JTAG:  The hardware interface required for downloading unit controller and I/O 
expansion module firmware.  JTAG refers to both the connector port attached to 
the unit controller as well as the cable used to download software to the BACnet 
communication module.  

 Flasher 5 Hardware:  The specific model of JTAG hardware used for unit 
controller downloading. 

 Flasher 5 Software:  The software that enables communication between the 
computer and the JTAG hardware. 
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 Fan coil unit controller and I/O expansion module .hex file:  The software file 
for the unit controller or I/O expansion module.  A separate .hex file is required for 
each board. 

Installing the Flasher Software  
Before the unit controller files can be downloaded, it is first necessary to install the 
Flasher software.  If the software has been previously installed and configured, 
proceed to the Downloading Unit Controller and I/O Expansion Module Software 
section.  Follow the steps below to install and configure Flasher: 

1. Download the newest version of Flasher software from the Segger website, 
http://www.segger.com/cms/downloads.html?pid=19 and save the file. 

2. Run the SetupFlasher application and click Next at the Welcome screen.  See 
Figure 5. 
 

Figure 5.  Welcome Screen 

   
 

3. Select the default parameters to install the program on the appropriate 
location on the hard drive and click Next. 

4. Check all three boxes for available options as shown in Figure 6 and click 
Next. 

5. When prompted to begin installation, click Next and then Finish. 
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Figure 6.  Flasher Choose Options Menu 

  

 

Download Fan Coil Unit Controller and I/O Expansion Module 
Software   
Once the Flasher software has been installed, follow the steps below to download the 
unit controller and I/O expansion module (if necessary).   The unit controller and I/O 
expansion module have different software files and must be downloaded separately.   
Although the following instructions refer to the unit controller, the same steps apply to 
the I/O expansion module as well. Refer to the Troubleshooting Guide and FAQ for a 
description of symptoms and recommended solutions to potential hardware or 
software issues. 
 
Note: New unit controller firmware may be installed over an existing version.  It is 

not necessary to uninstall firmware before loading a newer version.    

 
1. Refer to Figure 1 to verify the latest version of software. 
2. Remove power to the unit controller and the BACnet or LONWORKS 

communication module (if attached).  
3. Download the unit controller software, which is a “.hex” file type and save to 

the hard drive.  To request a copy of the software file, contact the ATS 
Technical Response Team at 315-282-6434. 

4. Connect the Flasher 5 hardware between the serial port on the computer (or a 
USB to serial converter) and the 10-pin connector on the unit controller or I/O 
expansion module.  The connector housing is keyed.  It only allows cable 
installation in one way, which is Pin 1 on the Flasher cable (brown wire) lined 
up with the Pin 1 on the unit controller. Refer to Figure 7. 
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Figure 7.  Flasher Cable Connection to Unit Controller or I/O Expansion Module 

 
 

5. Connect power to the Flasher 5 hardware. 
6. Prior to launching Flasher, check the communication port (i.e. COM1 or 

COM2) to which the Flasher hardware is connected.  The port number is 
required for Step 8.  Follow these steps to determine the port number: 

7. Navigate to the Control Panel and select System/Hardware/Device 
Manager/Ports. 

8. Verify the communication port shown (i.e. COM1, COM2, etc). 
9. Launch the Flasher program from the desktop shortcut icon 
10. If this is the first time downloading to the unit controller since installing the 

Flasher program, it is necessary to configure the software.  If this has already 
been done, proceed to Step 19.  Otherwise, follow Steps 11-18 below. 

11. Go to the Options menu and select Communications.  Select the 
communications port (as determined from Step 6) as shown in Figure 8 and 
then click OK. 

Figure 8.  Communications Parameters Menu 

 

12. Navigate to the Options menu  
a. Click on Device. 
b. Click Select Device in the Device Properties window. See Figure 9. 
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Figure 9. Device Properties   

 
 

When the Select Device window shown in Figure 10 appears: 
13. Select Renesas in the Manufacturer drop-down box. 
14. Select M38507 in the Group drop-down box.  
15. Highlight the device M38507F8FP with 1KB RAM and 32KB FLASH and then 

click the OK button twice. 

Figure 10. Select Device 

 
 

16. Navigate to the Options menu and select Passcode.   
17. Verify that all seven fields are set to FF as shown in Figure 11. 
18. Click the OK button. 
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Figure 11.  Flasher Passcode Configuration Menu 

   
 

19. Apply power to the unit controller.  The Target VCC field should change to 
approximately 5.0 Volts as shown in Figure 12.  If it does not, check the 
connection between the Flasher 5 hardware and unit controller to verify that 
the cable is installed properly. 

20. Set the system mode to OFF. Note that the digital display sensor, which is 
used to set the system mode, functions only when power is applied to the unit 
controller. 

21. Prepare the software file for downloading.   
a. Go to the File menu and select Open.  
b. Browse to the appropriate file and click OK.  The screen should 

populate as indicated in Figure 12. 
 

Figure 12.  Flasher Main Screen – Unit Controller when Applying Power and hex file 
is loaded 

 
 
22. To begin the download, select the Target menu and click Program and Verify.  

After a successful download, the screen shown in Figure 13 appears. 
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Figure 13.  Flasher Successful Download Screen 

   
 

23. Remove power from the unit controller and disconnect the Flasher 5 
hardware.   

24. Repeat steps 1-23 to complete this process for the I/O expansion module, if 
necessary. 

25. Apply power to the unit controller and allow it to run for 30 seconds to verify 
that the new configuration has been saved properly. 

26. Return the fan speed switch to the state it was in before Step 4 after both the 
unit controller and I/O expansion module have been programmed 
 

Note: Contact the ATS Technical Response Team at 315-282-6434 with any questions 
about downloading the unit controller or I/O expansion module software. 
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Downloading LONWORKS Communication 
Module Firmware Files  

Introduction 
The following section describes how to download and commission the LONWORKS 
communication module firmware files (XIF - eXternal Interface File and NXE file) for 
the MicroTech III fan coil unit controller.  This is done using industry-standard 
LONWORKS-specific software such as Echelon® LonMaker.  This document assumes 
that the user has the application installed and is familiar with the use of LonMaker or 
equivalent software. 

Hardware and Software Requirements 
You will need the following:  
 LONWORKS communication module installed on the unit controller 

 XIF/NXE files for “MicroTech III Fan Coil LONWORKS communication module”, 
available on www.daikinapplied.com or www.lonmark.org 

 LONWORKS application such as LonMaker-SR4 or OpenLNS CT, available from 
Echelon at www.echelon.com 

 Twisted pair shielded cable with 3-pin connector 

 Echelon TP/FT-10 to USB network interface, U10 or similar 

System Requirements 
 Computer with Windows7 or newer operating system.  Refer to www.echelon.com 

for compatibility with older versions of Windows 

 Standard web browser for access to www.daikinapplied.com 

Getting Started 
1. Verify that LONWORKS software such as LonMaker-SR4 is installed.  If not, refer 

to www.echelon.com or the system administrator. 
2. Verify that the LONWORKS communication module is properly installed on the unit 

controller (refer to IM 1012, available on www.daikinapplied.com). 
3. Download the LONWORKS communication module XIF/NXE files to the hard drive.  

The files are available from www.daikinapplied.com or www.lonmark.org. 
4. Connect TP/FT-10 network channel to the computer using the USB network 

interface.   
5. Determine the LONWORKS Interface name for later reference. Do this by 

navigating to Control Panel/ LONWORKS Interfaces.  See Figure 14. 
6. Insert the other end of the TP/FT-10 connector to the LONWORKS communication 

module pins A and B.  See Figure 15. 
7. Apply power to the unit controller. 
 

Note: If device has not been commissioned, the yellow Service LED flashes ON/OFF once 
every half second.  See Figure 54 in the Troubleshooting Guide and FAQ section for 
more detailed descriptions of LED activity. 



OM 1095 • FAN COIL UNIT CONTROLLER 14 www.DaikinApplied.com

                            14                                             OM 1095 

Figure 14.  LONWORKS Interface Name 

 

 
 

Figure 15.  LONWORKS Communication Module  
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Configuring the LonWorks Communication Network 
The following section describes how to use LonMaker to create a LONWORKS 
communication network drawing, and import the Fan Coil Unit Device Template into 
the network. 
 
1. Double-click on the LonMaker desktop icon and the Echelon LonMaker Design 

Manager appears as shown in Figure 16. 
2. Either create a new network or select an existing network. 

a. To select an existing network: 
i. Select the network from the “Drawing directory” drop-down menu. 
ii. Press the “Open Network” button. 
iii. Proceed to the “Commissioning the LONWORKS Communication 

Module” section. 
b. To create a new network:  

i. Enter a name in the “Network name” field and then click the Create 
Network button. 

ii. Press the “Next” button when the screen shown in Figure 17 
appears. 

 

Figure 16: Echelon LonMaker Design Manager 
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Figure 17.Network Setup Screen 

 

3. Select the Network Interface Name (as determined in step 5 of the Getting Started 
section).  See Figure 18. 

4. Click Next. 
5. Verify the Management Mode is “OnNet” and click “Finish”.  See Figure 19. 
 

Figure 18. Network Interface Name Screen 
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Figure 19. Management Mode Screen 

 
 
6. A screen similar to Figure 20 appears. 
7. Drag the Device icon (shown on the left-hand side of the image in Figure 20) to 

the center of the screen. 
 

Figure 20: LNS Network Interface Screen 

 
 
8. The New Device Wizard then opens.  See Figure 21. 
9. Provide a “Device name” and check “Create new device template”. 
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Figure 21. New Device Template Screen 

  

 
10. Click Next.  The screen shown in Figure 22 appears. 
11. Verify that “Load XIF” is selected. 
12. Click Browse to locate the LONWORKS communication module XIF file from the 

hard drive and then click Finish. 
 

Figure 22. XIF Definition Screen 

  
13. The network drawing screen will then open as shown in Figure 23. 
14. The “MTIII FCU” LonWorks device will be shown in yellow indicating the device is 

decommissioned. 
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Figure 23.  Network Drawing Screen 

 

Commissioning the LonWorks Communication Module 
The LONWORKS communication module is ready for network commissioning after the 
Device Template has been properly loaded into LonMaker using the XIF file and an 
“FCU device” exists in the network drawing area as shown in Figure 23.  
Follow these steps to begin the commissioning process: 

1. Right click on the decommissioned LonWorks device and select 
“Commissioning” and left click on “Commission”. 

2. Check “Load application image” when the screen shown in Figure 24 appears.  
3. Click Browse to locate the LONWORKS communication “NXE” Image file from 

the hard drive and then click Next. 
 

Figure 24. Application Image Details 

 
 

4. Verify that the following are all selected once the screen shown in Figure 25 
appears:  

a. State setting is “Online” 
b. Source of CP Values setting is “Defaults” and “Include NV type CPs” 
c. Device Specific CPs setting is “Update with other CPs” 

5. Press the Next button. 
6. Ensure “Service pin” is selected and then click Finish.  See Figure 26. 
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Figure 25.  Device Details 

 
 

Figure 26.  Service Pin Screen 

 
 

7. The screen in Figure 27 appears. 
8. Press the service pin button on the LONWORKS communication module.  Refer 

to Figure 15 for the location of the service button. 
 

Figure 27. Service Pin Entry 
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At this point, the application image starts loading and the LONWORKS communication 
module is then commissioned.  This process takes approximately one minute.  See 
Figure 28. 
 
The “MTIII FCU device” changes color to green, which indicates successful 
commissioning.  See Figure 29.    

 

Figure 28. Loading Application 

 
 
 

Figure 29.  LONWORKS Communication Module - Commissioned  

  
 
In order to program another LONWORKS device, it is necessary to first decommission 
the existing device by following these three steps: 

1. Right click on the commissioned LONWORKS device. 
2. Select Commissioning. 
3. Left click on Decommission. 
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Downloading BACnet Communication Module 
Firmware 
The following section describes how to do the following:  

1. Install the hardware and software tool sets required for downloading BACnet 
communication module firmware 

2. Install and configure the BACnet communication module firmware itself 
Successful download of the BACnet communication module firmware requires the 
use of a third-party tool.  There are two recommended tool sets, both of which have 
separate hardware and software components.  One of these must be installed prior to 
the BACnet communication module firmware.  

 The first tool set is called Smart ARM Microcontroller – Boot Assistant (SAM-
BA) software, which is used in conjunction with the ATMEL SAM-ICE 
hardware.   

 The second tool set is called J-Flash software, which is used in conjunction 
with J-Link hardware.   

The choice of one versus the other is user preference.  While there may be other 
options available, these tools are both supported by the ATMEL® Corporation, the 
manufacturer of the microcontroller used in the BACnet communication module. 
The instructions for using the ATMEL SAM-ICE hardware and SAM-BA software tool 
set is described first, followed by the instructions for using the J-Link hardware and J-
Flash software tool set.  The BACnet communication module firmware download 
process is also explained in each section. 

Downloading with ATMEL SAM–ICE Hardware and SAM-BA 
Software 
Hardware and Software Requirements 
You will need the following: 

 BACnet communication module installed on the fan coil unit controller 
 ATMEL SAM-ICE hardware  

o Available at www.DigiKey.com.  Reference part number: AT91SAM-
ICE-ND or equivalent (see Figure 30.) 

 The most current version of SAM-BA software  
o A free download is available at 

http://www.atmel.com/tools/ATMELSAM-BAIN-
SYSTEMPROGRAMMER.aspx) 

 Computer with a supported Windows operating system (refer to the ATMEL 
website for details) 

 BACnet .bin file  
o Contact the Controls Customer Support group at 866-462-7829 to 

request a copy of this firmware file 
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Terminology 
 ATMEL SAM-ICE:  The specific model of hardware used for BACnet 

communication module firmware downloading. 
 BACnet.bin file:  The BACnet communication module firmware. 
 JTAG:  The hardware interface required for downloading BACnet firmware.  JTAG 

refers to both the connector port attached to the unit controller as well as the 
cable used to download software to the BACnet communication module.  

 Smart ARM Microcontroller – Boot Assistant (SAM-BA):  The software that 
enables communication between the computer and the SAM-ICE hardware. 

 

Figure 30.   ATMEL SAM-ICE Hardware & SAM-BA Software 

  
 

Getting Started 
1. Download the BACnet .bin file to the hard drive. 

a. Contact the ATS Technical Support Team at 315-282-6434 to request 
a copy of this firmware file. 

2. Verify that the BACnet communication module is properly installed on the unit 
controller (see IM 1013 for details, available on www.daikinapplied.com). 

3. Apply power to the unit controller. 
 

Download and Install the SAM-BA Software 
It is first necessary to install the latest version of SAM-BA software before the BACnet 
communication module firmware file can be loaded. Follow the steps below to install 
and configure the latest version of SAM-BA software for Windows applications.  Note 
that Windows7 uses v2.15 or newer. 

1. Download the software from ATMEL’s website: 
www.atmel.com/tools/ATMELSAM-BAIN-SYSTEMPROGRAMMER.aspx.  

a. Select the current version of SAM-BA for Windows installation files.  
b. Verify that the software is compatible with the computer’s operating 

system.   
2. Open the .exe file.  Select the default parameters during installation. 
3. Select both the “Create new entry in start menu” and “Add shortcuts to 

desktop” check boxes.  



OM 1095 • FAN COIL UNIT CONTROLLER 24 www.DaikinApplied.com                            24                                             OM 1095 

4. Restart the computer after installation is complete.  A new desktop icon 
appears after successful software installation and start-up.    
 

Launch and Configure the SAM-BA Software 
Once installed, SAM-BA must then be configured for use with the BACnet 
communication module.  The following section describes this process. 
 
Note: Performing this procedure returns all BACnet network parameters to default 

values.  Record any previously configured settings before proceeding.  
 

1. Connect the SAM-BA hardware between the USB port on the computer and 
the 20-pin connector on the BACnet communication module.  The notch on 
the JTAG cable fits into an opening on the 20-pin connector on the BACnet 
communication module. See Figure 32. 

2. Launch the SAM-BA program from the desktop icon.   
a. If the shortcut icon does not appear, navigate to the Start menu, 

located on the lower left-hand corner of the screen, then click 
Programs, Atmel Corporation, and then SAM-BA v2.1x. 

3. Select “\jlink\ARM0\” from the “Select the connection” drop-down box as shown in 
Figure 31. 

Figure 31. Select Connection Type 

 
 
4. Select AT91SAM7S256-ek from the “Select your board” drop-down box.  This 

is the ATMEL microcontroller chip part number used by the BACnet 
communication module. This part number is located on the top of the chip.  
See Figures 32 and 33. 

 

Note: It may be necessary to download a J-Link USB driver in order for it to recognize the 
new hardware.  If so, refer to www.segger.com/jlink-software for downloading 
instructions. 
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Figure 32. BACnet Communication Module – Location of Important Features 

 

                                   
                          
  
     

 
 

Figure 33.  Select the Microcontroller Part Number           

 
 
 
The screen shown in Figure 34 appears upon successful communication between the 
SAM-BA program and the BACnet communication module. 
 

20-Pin Connector 
(Attaches to JTAG 
connection cable) 

ATMEL Microcontroller 
Part number indicated on the top of the chip 

Default 
Button 

(S2) 

Reset 
Button (S1) 

 

LEDs 
(D1-D4) 
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Figure 34.  Successful Communication 

  
 

Download BACnet Communication Module Firmware 
 

! CAUTION 

The following procedure returns all BACnet parameters to factory default values. It is recommended that 
existing parameters are saved prior to starting this process.  See Appendix A in the MicroTech III Fan Coil 
BACnet Communication Module Installation Manual, IM 1013, and MicroTech III Fan Coil Protocol 
Document, ED 15135 (both available on www.daikinapplied.com) for additional information. 

 
Once the configuration settings have been established, it is now possible to download 
the BACnet communication module firmware. 

1. Click on the open folder icon in the Send File Name field.   See Figure 34. 
2. Browse to the location on the hard drive where the BACnet communication 

module .bin file has been saved. 
3. Click the Send File button. 
4. If the program prompts the user to unlock the involved lock region(s), click the 

Yes button to unlock the flash memory before performing the download.  See 
Figure 35. 

Figure 35. Unlock Involved Flash Regions to Program 

  
 
A dialog box appears and reports a “Sending File to the Target” message along with 
a scrolling status display of the items.  See Figure 36. 
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Figure 36.  Sending File to Target 

   

5. When the program prompts the user to lock the involved lock region(s), click 
the Yes button after performing the download.  See Figure 37. 

Figure 37.  Lock Involved Flash Regions 

   
 

6. Select “Compare sent file with memory” after completing the download.   
 

The program confirms that the file sent matches the file within the BACnet 
communication module, indicating that the firmware has been successfully 
downloaded. 
 
7. Remove power from the unit controller. 
8. Remove the JTAG cable connection from the BACnet communication module. 
9. Press and hold the Default and Reset push buttons on the BACnet 

communication module. See Figure 32. 
10. Apply power to the unit controller. 
11. Release the Reset push button, and continue to hold the Default push button 

until all four BACnet communication module LEDs (D1 to D4) are on steady.  
See Figure 32. 
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12. Verify that the BACnet communication module properly runs the application by 
observing that: 

a. LED D1 flashes on and off approximately every half second, indicating 
application software is running 

b. LED D2 flashes in bursts approximately every half second, indicating  
communication between the unit controller and the BACnet 
communication module 

c. LED D3 flashes for each message transmitted to the MS/TP network 
d. LED D4 flashes for each message received from the MS/TP network 

 
All BACnet communication parameters have now been returned to default settings.  
Reconfigure network values as required. See ED 15135, available on 
www.daikinapplied.com, for further details. 
 
Note:    Refer to the Troubleshooting Guide and FAQ section on page 37.  If necessary, 

contact the Controls Customer Support group at 866-462-7829 for technical 
assistance.   
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Downloading with J-Link Hardware and J-Flash Software 
The following section describes how to install and set up the J-Link hardware and J-
Flash software programming tools.  It then explains how to download the BACnet 
communication module firmware once J-Link and J-Flash have been successfully 
configured. 
 

Note: Contact the Controls Technical Support Team at 315-282-6434 assistance regarding 
the J-Link and J-Flash tools or the BACnet communication module firmware 
downloading process. 

Hardware and Software Requirements 
You will need the following:  
  BACnet communication Module installed on the unit controller  

 The latest J-Link hardware (including JTAG cable), Model 8.08.00 or newer 

 Available at www.segger-us.com/jlinkjtagemulator.htm 

 J-Flash software  

 Available at www.segger.com/cms/jlink-software.html 

 Computer with compatible operating system (refer to the Segger website for 
details) 

 BACnet “.hex” file  

 Contact the ATS Technical Support Team at 315-282-6434 to receive the file 

Definitions 
 BACnet.hex file:  The firmware hex file of the BACnet communication module. 

 J-Flash Software:  The software that enables communication between the 
computer and the J-Link hardware. 

 J-Link:  The specific model of JTAG hardware used for the BACnet 
communication module firmware downloading. 

 JTAG:  The hardware interface required for downloading BACnet firmware.  JTAG 
refers to both the connector port attached to the unit controller as well as the 
cable used to download software to the BACnet communication module. 

Getting Started 
1. Download the BACnet .hex file to the hard drive. 
2. Verify that the BACnet communication module is properly installed on the unit 

controller (refer to Reference Documents section for additional details.) 
3. Apply power to the unit controller. 

Install the J-Flash Software  
It is first necessary to install the latest version of J-Flash before the BACnet 
communication module firmware file can be uploaded. Follow the steps below to 
install and configure the latest version of J-Flash.  
 

Note: J-Flash software is licensed and does not operate unless it is properly activated. 
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1. Navigate to the Segger Microcontroller web site www.segger.com/cms/jlink-
software and select “software and documentation pack.”  See Figure 38. 

 

Figure 38. Download J-Flash Software   

       
 

2. Double-click on the zip file that contains the installation application. 
3. Select the default parameters during installation.   
4. Select both the “Create new entry in start menu” and “Add shortcuts to 

desktop” check boxes as shown in Figure 39. 
 

Figure 39.  J-Flash Choose Options Menu 

   
 

Launch and Configure the J-Flash ARM Software  
Once J-Flash ARM has been successfully downloaded and installed, it can then be 
opened and configured for use with the BACnet communication module. 
 
Note: Performing the following configuration steps returns all BACnet network parameters 

to default values.  Record any previously configured settings before proceeding.  
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1. Connect the J-Link hardware between the USB port on the computer and the 
20-pin connector on the BACnet communication module.  The notch on the J-
Link cable fits into an opening on the 20-pin connector on the BACnet 
communication module.  See Figure 32.                  

2. Launch J-Flash ARM from the desktop.   
a. If the desktop icon does not appear, open J-Flash ARM from the Start 

menu on the lower left-hand side of the screen.  Navigate to Programs, 
SEGGER, then click on J-Flash ARM. The screen shown in Figure 40 
then appears. 

Figure 40. J-Flash Initial Project Screen 

    

Configure J-Flash ARM Software 
Follow steps 3-10 below to establish the proper settings if J-Flash ARM has not been 
previously configured to download the BACnet communication module firmware.  
 

3.   Navigate to the Options menu and select Project Settings.  
4. Select USB Device 0 from the General tab.  See Figure 41. 
5. Select Engineering from the User interface mode.    

Figure 41. Project Settings – General Tab   
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6. Click on the Target Interface tab.  See Figure 42. 
a. Select JTAG from the drop-down box.   
b. Select 10 kHz from the JTAG speed before init drop-down box. 

Figure 42. Target Interface Tab 

  
7. Click on the CPU tab.  See Figure 43. 

a. Select Atmel AT91SAM7S256 from the Device drop-down menu. 
b. Enter 200000 in the Addr box and then select 64 KB from the drop-

down menu. 

Figure 43. CPU Tab - Device Selection 

  
8. Click on the Flash tab.  See Figure 44. 

a. Verify that the Base Addr is 00100000 
b. Verify Organization is set to 32 
c. Verify Bits x is set to 1 
d. Select the Start/End sector radio button 

i. Choose Sector[0]: 0x0 as the Start Addr 
ii. Choose Sector[1021]: 0x3FDFF as the End Addr 
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Figure 44. Flash Tab 

  
 

9. Select the Production tab.  See Figure 45. 
a. Verify that Erase, Program, Verify, and Start application boxes are 

checked. 
b. Verify that Sectors if not blank is selected in the drop-down box.  
c. Verify that CRC is selected in the drop-down box. 
d. Click Apply and then OK to exit the Project Settings menu. 

 

Figure 45. Production Tab 

  

10. Navigate to the Options menu and select Global Settings.  From the main J-
Flash screen:  

a. Verify that all Operation and Logging parameters match those shown 
in Figure 46. 

b. Click OK. 
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Figure 46.  Global Settings 

  

 

Download BACnet Communication Module Firmware 
 

! CAUTION 

The following procedure returns all BACnet parameters to factory default values. It is recommended that 
existing parameters are saved prior to starting this process.  See Appendix A in the MicroTech III Fan Coil 
BACnet Communication Module Installation Manual, IM 1013, and MicroTech III Fan Coil Protocol 
Document, ED 15135 (both available on www.daikinapplied.com) for additional information. 

 
J-Flash is ready to use for downloading BACnet communication module firmware 
once the configuration settings have been established.  Perform these steps to 
download the firmware: 

1. Apply power to the unit controller. 
2. Navigate to Target and select Connect from the main J-Flash screen. 
3. Verify connection by viewing the log message at the bottom of the screen that 

indicates “Connected Successfully.” 
4. Close any open data files like the one highlighted in red (see Figure 47). 

Figure 47.  Successful Connection Message   
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 5.  Select Open from the File menu in the main J-Flash screen.  
6.  Browse to the location on the hard drive where the BACnet communication 
module .hex file has been saved. 
7.  Click on the .hex file and select Open.    
8.  Verify that the Log screen message indicates the data file has opened 
successfully.  See Figure 48. 
 

Figure 48.  Successful Data File Open Message  

    
 

9.    Apply power to the unit controller. 
10.  Remove (if connected) the jumper from pin 1 and pin 2 on J2 of the   BACnet 
communication module.   
11.  Select Auto from the Target menu in the main J-Flash screen to begin the 
programming process.  See Figure 49. 

 

Figure 49. Program & Verify Device Using the Auto Command 

  
 
12. Click OK once the screen shown in Figure 50 appears.  The firmware has now 
been successfully downloaded. 
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Figure 50. Successful Programming 

    
 
13.  Remove power from the unit controller. 
14.  Remove the JTAG cable connection from the BACnet communication module. 
15. Press and hold the Default and Reset push buttons on the BACnet 

communication module. See Figure 32. 
16. Apply power to the unit controller. 
17. Release the Reset push button, and continue to hold the Default push button until 

all four BACnet communication module LEDs (D1 to D4) are on steady.  See 
Figure 32. 

18. Verify that application is operating correctly by observing the following LED 
activity: 

a. LED D1 flashes on and off approximately every half second. This indicates 
that the application is running. 

b. LED D2 flashes in bursts approximately every half second.  This indicates 
communication between the unit controller and the BACnet 
communication module. 

c. LED D3 flashes for each message transmitted to the MS/TP network. 
d. LED D4 flashes for each message received from the MS/TP network. 

19. All BACnet communication parameters are at default values.  Reset network 
values as required. See ED 15135, available on www.daikinapplied.com, for 
further details. 

 
Note:    Refer to the Troubleshooting Guide and FAQ section on page 37 or contact 
the Controls Customer Support group at 866-462-7829 for technical assistance.   
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Troubleshooting Guide and FAQ 
This guide is intended to be a helpful reference and source of supplemental 
information. It provides answers to common questions about the MicroTech III fan coil 
controls subjects covered in previous sections of this manual.  The troubleshooting 
topics are organized into five categories: fan coil equipment configuration, unit 
controller and I/O expansion modules, BACnet or LonWorks communication modules, 
Flasher tools, and finally J-Link tools.  

The bulleted items below link directly to the detailed information and solutions given 
within each of the five main subjects. Click a link to navigate quickly, or scroll through 
to the relevant section. 

Fan coil equipment configuration 
 Verify the jumper settings based on the fan coil model and unit configuration 
 Binary to hexadecimal  conversions 
 Three methods of setting equipment configuration: 

o Unit controller low level diagnostics 
o BACnet communication diagnostics 
o LonWorks interface 

Unit controller and I/O expansion module 
 Room sensor is not responding properly 

BACnet and LonWorks communication modules  
 Not able to write to Network Setpoint Inputs 

 BACnet 
 No LEDs are lit 
 All four LEDs are lit 
 DI, D2 or D4 LED never blinks 
 CRC error 
 Communication module cannot be configured through the serial port 

 LonWorks 
 Service Pin LED is not lit 
 BAS does not “see” LonWorks configuration properties 

Flasher hardware and software 
 Main screen does not populate 
 Flasher LED is red 
 Target VCC Field is not 5.1V 
 Target VCC or Range fields are in red text 
 Downloading error messages: 

o Target chip: busy does not react 
o Supply voltage too low 
o ID mismatch 
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J-Link hardware and software 
 Failed to connect error message 

Fan Coil Equipment Configuration 
This section describes the equipment options that can be configured using software 
jumper settings for the unit controller and I/O expansion module.  See Table 1 for 
option details.  Table 2 provides a binary to hexadecimal conversion summary. 
Additionally, three methods for setting the fan coil equipment configuration are 
described in detail. An example of unit configuration is also included for reference. 

Table 1. Equipment Configuration Software Jumpers 
Function Bit / Binary Setting Model / Feature 

Service Test Mode Byte 1: b0 0 = Normal Operation 
1 = Service Test Mode 

Continuous / Cycling Fan Byte 1: b1 0 = Continuous Fan 
1 = Cycling Fan 

Setpoint Adjust – Temperature 
Range Byte 1: b2 0 = Short Range (-5 to +5 °F) 

1 = Long Range (55 to 95 °F) 

IO Expansion Unit controller 
Selection Byte 1: b3 

0 = No IO Expansion Unit controller 
Present 
1 = Enable IO Expansion Unit 
controller 

Economizer Selection Byte 1: b4 0 = No Economizer Present 
1 = Enable Economizer Use 

N.O. / N.C. Two Position 
Heating Valve Byte 1: b5 0 = Normally Open Heating Valve 

1 = Normally Closed Heating Valve 
N.O. / N.C. Two Position 
Cooling Valve Byte 1: b6 0 = Normally Open Cooling Valve 

1 = Normally Closed Cooling Valve 
Two Position / Modulating 
Valves Byte 1: b7 0 = Two position Hydronic Valves 

1 = Modulating Hydronic Valves 
 

Electric Heat Selection 
Byte 2: b1=0, b0=0 
Byte 2: b1=0, b0=1 
Byte 2: b1=1, b0=0 

00 = No Electric Heating 
01 = One Stage Electric Heat 
10 = Two Stage Electric Heat (Future) 
11 = Not Valid 

Hydronic Valves Selection 

Byte 2: b4=0, b3=0, b2=0 
Byte 2: b4=0, b3=0, b2=1 
Byte 2: b4=0, b3=1, b2=0 
Byte 2: b4=0, b3=1, b2=1 
Byte 2: b4=1, b3=0, b2=0 

000 = No Hydronic Valves 
001 = 2-Pipe Heating Only 
010 = 2-Pipe Cooling Only 
011 = 2-Pipe Heat & Cool 
Changeover 
100 = 4-Pipe Hydronic Heat & Cool 

Fan Speed Selection 
Byte 2: b6=0, b5=0 
Byte 2: b6=0, b5=1 
Byte 2: b6=1, b5=0 

00 = 1Speed (Uses: High) 
01 = 2Speed (Uses: Low, High) 
10 = 3Speed (Uses: Low, Med, High) 

Freeze Fault Detect 
Binary Input Selection Byte 2: b7 0 = Disable Binary Input 

1 = Enable Binary Input 
 
Emergency Shutdown 
Binary Input Selection Byte 3: b0 0 = Disable Binary Input 

1 = Enable Binary Input 
Dirty Air Filter 
Binary Input Selection Byte 3: b1 0 = Disable Binary Input 

1 = Enable Binary Input 
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Table 2. Binary to Hexadecimal Conversions 

Binary Hexadecimal  Binary Hexadecimal 
0000 0  1000 8 
0001 1  1001 9 
0010 2  1010 A 
0011 3  1011 B 
0100 4  1100 C 
0101 5  1101 D 

   6  1110 E 
0111 7  1111 F 

 

Equipment Configuration Example 
LonWorks “nciSoftJumpers” are presently set to: FA, D0, 01, 00. 

 

 Byte 1 (FA hexadecimal = 1111 1010 binary): 
b0=Normal Operation Mode; b1=Cycling Fan; b2=Short Range SP Adjust; 
b3=IO Expansion Unit controller is required; b4=Economizer is Enabled; 
b5=Normally Closed Two Position Heat Valve; b6=Normally Closed Two 
Position Heat Valve; b7=Modulating Hydronic Valves. 

 
 Byte 2 (D0 hexadecimal = 1101 0000 binary): 

b0 to b1=No Electric Heating; b2 to b4=4-Pipe Hydronic Heating & 
Cooling; b5 to b6=3-Speed Fan; b7=Freeze Fault Detect binary input is 
enabled. 

 
 Byte 3 (01 hexadecimal = 0000 0001 binary): 

b0=Emergency Shutdown binary input is enabled; b1=Dirty Air Filter 
binary input is disabled. 

 
 Byte 4 (00 hexadecimal = 0000 0000 binary): 

Security Unlock byte set to 80 when performing a write operation; 
automatically clears to zero after write process is complete. 

 

Note: Binary and hexadecimal displays are numeric values, thus the most significant numeric 
digit is always shown on the left, and the least significant numeric digit is always on the right. 

 

Methods to set the Fan Coil Unit Equipment Configuration 
The fan coil equipment configuration is writable using one of the three following 
methods: 

1. The unit controller low-level diagnostics serial port 
2. BACnet communication module diagnostics serial port 
3. LonWorks communication module network interface 
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Method #1 Setting the Equipment Configuration Using Unit Controller Low-Level 
Diagnostics 

Hardware / Software Required:  
 Computer with EIA-232 Serial Port Connection 
 Terminal Emulator Program (e.g. Microsoft Windows HyperTerminal or 

PuTTY) 
 Standard Serial Port Cable (Not a NULL Modem) 
 JTAG Diagnostic Serial Port Cable Assembly (See Figure 51) 

Figure 51. JTAG Diagnostic Serial Port Cable Assembly 

SerialComm
TTL-232-5p

Signal Converter
BLACK

Bare

BLACK

Bare

RED

Three conductor shielded cable
Each conductor 24 AWG
Maximum length ten feet

JTAG connector is 10 position AMP 
A25901-ND housing with A33431-ND pins

10 K ohm 

5
G

R
D

4 N
C

3
O

U
T

2 IN
1 N
C

BLACK

Bare

Red

RED

Pin 1

 
 

The configuration procedures are as follows: 
1. Connect the computer serial port to the unit controller serial port using the 

“JTAG Diagnostic Serial Port Cable Assembly” as shown in Figure 51. 
2. Start the terminal emulator program. 
3. Configure the terminal emulator serial communications for 19200 bps, 8 data 

bits, 1 stop bit, no parity, and no flow control. 
4. Press the ‘?’ key to view the software part and version numbers, along with 

the present equipment configuration settings.  This step also verifies a solid 
communication link between the computer and the unit controller. 

5. If the equipment configuration needs modification, continue on to the following 
steps: 

a. Enter the “@” key to inform the unit controller that four hexadecimal 
pairs will represent the new equipment configuration options. 

b. Enter three hexadecimal pairs as determined by the desired equipment 
configuration options, and always set the fourth byte pair to 80.  An 
example of a valid configuration write string is “@FAD00180”. 

c. Verify the first three bytes are echoed back correctly from the unit 
controller in the Config Settings message display.  The new 
configuration response only occurs if the correct number of bytes are 
entered and unlocked properly.  The fourth byte, which is the security 
byte, is automatically cleared to zero. 
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d. If the echoed equipment configuration settings are correct, press the 
“W” key. The diagnostic message, EE Write=Pass appears, indicating 
the write operation was successful. 

e. Restart the unit controller.  The diagnostic message, EE Read=Pass 
then appears, indicating the read operation was successful. 

f. Verify the new equipment configuration options have been 
implemented, as indicated by the Config Settings diagnostic message. 

g. Verify the Invalid Equipment Configuration alarm is not annunciated by 
the unit controller.  This is indicated on the room sensor LED, through 
the network, or through the low-level alarm diagnostic message. 

 
Method #2 Setting the Equipment Configuration Using BACnet Module Diagnostics 

 Hardware / Software Required:  
o Computer with EIA-232 serial port connection 
o Terminal Emulator Program, e.g., Microsoft Windows HyperTerminal 

or PuTTY 
o DB9 female-female Modem to Modem (DCE to DCE) Serial Port 

Crossover Cable 
 The configuration procedures are as follows: 

1. Connect the computer serial port to the BACnet diagnostic serial port. 
2. Start the terminal emulator program. 
3. Configure the terminal emulator serial communications for 19200 bps, 8 

data bits, 1 stop bit, no parity, and no flow control. 
4. Press Enter to display the BACnet main diagnostic menu, along with the 

present equipment configuration settings.  This step also confirms the 
communication link between the computer and the BACnet communication 
module. 

5. If the equipment configuration requires modification, follow these steps: 
a. Press “6” to be prompted for the equipment configuration settings. 
b. Enter three hexadecimal pairs as determined by the desired 

equipment configuration options. Always set the fourth byte pair to 
80, which is then followed by pressing Enter.   

i. Press Enter to display the BACnet Configuration Menu. See 
Figure 52. 

ii. Verify the first three bytes are echoed back correctly from 
the BACnet communication module in the Config Settings 
message display.  The fourth byte is automatically cleared 
to zero. 

c. Wait ten seconds to allow the unit controller to receive the new 
configuration settings. 

d. Restart the unit controller. 
e. Verify the new equipment configuration options have been 

implemented, as indicated by the Config Settings diagnostic 
message. 
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f. Verify the Invalid Equipment Configuration alarm is not 
annunciated by the unit controller.  This is indicated on the room 
sensor LED or through the network. 
 

Figure 52. BACnet Configuration Menu 

   
 

Method #3 Setting the Equipment Configuration Using the LonWorks Network 
Interface 

This method uses the standard LonWorks network interface to read and write the 
equipment configuration properties using the “nciSoftJumpers” network variable. 
 
The procedures are as follows: 

1. Read the “nciSoftJumpers” configuration property through the network. 
2. If the equipment configuration needs modification, continue on to the following 

steps: 
a. Write the “nciSoftJumpers” configuration property network variable to 

the new value, with the last of the four hexadecimal pairs always set to 
80. 

b. Wait ten seconds allow the unit controller to receive the new 
configuration settings. 

c. Restart the unit controller using the LonWorks device management 
Reset command. 

d. Read the “nciSoftJumpers” configuration property values. 
e. Verify the first three hexadecimal pairs properly reflect the new 

equipment configuration options. 
f. Verify the Invalid Equipment Configuration alarm is not annunciated by 

the unit controller.  This is indicated on the room sensor LED or 
through the network. 
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Note: Binary & Hexadecimal displays are numeric values, thus the most significant numeric 
digit is always shown on the left, and the least significant numeric digit is always on the right. 
 

Fan Coil Unit Controller and I/O Expansion Module 
The following section describes issues and the corresponding troubleshooting steps 
for the fan coil unit controller with or without an I/O expansion module.  Refer to OM 
1111, available on www.daikinapplied.com, for complete details about LED activity, 
faults, and additional troubleshooting topics. 

Q: Room Sensor LED does not come on, or comes on for a little while, then 
goes out 
A: This could be caused by bad power to the unit controller, incorrect wiring from the 
unit controller to the room sensor LED, possibly defective hardware, or the unit is 
configured to operate in the service test mode. 

• Verify that the unit controller has 24 VAC 
• Verify that the unit is not operating in the service test mode 
• Verify if the unit runs/communicates when the LED is off 
• If it runs properly without the LED, check the LED wiring connection 
• Download application code to the unit controller 
• Replace hardware, if necessary 

Q: Unit has a room sensor and is constantly in cooling mode or the space 
temperature constantly reads higher than actual room temperature 
While the unit controller has separate connections for both return air and room 
temperature sensors, it is not possible for both to be used at the same time.  Having 
both sensors connected will cause the room temperature to read higher than the 
actual temperature. 
A: Disconnect the return air sensor. 

BACnet & LonWorks Communication Modules 
The following section describes issues and the corresponding troubleshooting steps 
that apply to the BACnet or LONWORKS communication modules for network 
integration. 

Q: Cannot write to network setpoint input but space temp reads valid value 
A: The room sensor setpoint adjustment has been enabled. 
For LONWORKS, set nciLocSetEnable to “Disable” or for BACnet, set MSV 12 to “1” 
(defaults are “Enable” and “2.”) 

Troubleshooting the BACnet Communication Module 
The following section applies only to the BACnet MS/TP communication module. 

Light Emitting Diodes (LEDs) 
The BACnet communication module has four LEDs that indicate the status of the 
module, the connection to the unit controller and/or BACnet network.  These LEDs 
are useful for verifying communication between the unit controller and the network, as 
well as diagnosing a potential problem.  Figure 53 provides a description of the LED 
activity.  For more details, see IM 1013, available on www.daikinapplied.com. 
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Figure 53.  BACnet Communication Module - LED Activity Details 

LED Function Description 
D1 Program Running Program main loop activity 
D2 Unit Controller Message SPI Activity, LED on during unit controller message 
D3 MS/TP Transmit Flashes on when transmitting a MS/TP message 
D4 MS/TP Receive Flashes on when receiving a MS/TP message 

 

Q:  No LEDs are lit 
A: The communication module may not be properly installed or may not have the 
BACnet application software loaded. 

• Remove the communication module and then reinstall it, verifying that the 
connector lands on all of the pins (it is very easy to either miss just one pin or 
all of the pins even with the standoffs.) 

• If the communication module is properly installed, try it on a different unit and 
if the LEDs still do not function properly, replace the communication module.  

• Re-download the BACnet software in the communication module.  Contact 
the Controls Customer Support group at 866-462-7829 before 
proceeding with this option. 

 
Q: All four LEDs are lit 
A: The BACnet application software has not been properly downloaded. 

 Re-download the BACnet software in the communication module  
 Replace the BACnet communication module 

 
Q: Program LED (D1) never blinks 
A: The BACnet software is not running correctly in the communication module. 

• Re-download the BACnet software in the communication module.  
• Replace the BACnet communication module. 

 
Q: SPI Comm LED (D2) never blinks 
A: The communication module is not communicating with the unit controller. 

• Verify that unit controller is controlling the fan coil unit 
• Re-download the unit controller application code  
• Re-download the BACnet software in the communication module 
• Install the communication module on a different unit to determine if the 

problem is associated with the unit controller or the communication module 
 
Q: RX LED (D4) never blinks 
A: The communication module is communicating with the unit controller but not the 
network. 

• Verify the BACnet MS/TP settings through the serial port on the communication 
module (check baud rate and any potential addressing conflicts) 

• Re-download the BACnet software in the communication module  
• If the network settings are correct and the application software is functioning 

properly, this could indicate a hardware defect.  Replace the communication 
module, if necessary. 
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Q: CRC errors 
A: The BAS indicates “CRC errors” at the workstation.  
Solution - Upgrade the communication module to the newest version of BACnet 
software.  It is not necessary to upgrade the unit controller or I/O expansion module 
software. 
 
Q: Communication module cannot be configured through serial port 
A: This could be caused by an incorrect or defective cable used to configure the 
communication module, software installation error, a previous change in the serial 
port settings, or potentially defective hardware. 

• Verify that the communication module is connected with a DB9 female-female 
(modem-modem) serial cross-over cable. Refer to the MicroTech III Fan Coil 
Unit Controller Protocol Document, ED 15135, available on 
www.daikinapplied.com. 

• Confirm that the serial terminal device application settings are correct. . Refer 
to the MicroTech III Fan Coil Unit Controller Protocol Document, ED 15135, 
available on www.daikinapplied.com.  

• Verify that the LED activity is normal.  See Figure 54. 
• Try resetting the communication module back to original default settings. 
• Re-download the BACnet software in the communication module.  
• Replace the communication module, if necessary. 

 
Troubleshooting the LONWORKS Communication Module 
The following section applies only to the LONWORKS communication module. 
 

The LONWORKS communication module has an LED that indicates the status of the 
module itself, the connection to the unit controller, or the LONWORKS network.  This 
LED is useful for verifying communication between the LONWORKS communication 
module and the network and for diagnostic purposes.  Figure 54 provides a 
description of the LED activity.  Refer to the LonWorks Communication Module 
Installation Manual, IM 1012, available on www.daikinapplied.com. 
 

Figure 54. LONWORKS Communication Module - LED Activity Details 

LED Activity Description 
LED flashes once when power has 
been applied, or comes ON when 
pressing the Service switch  

Normal operation for a commissioned LONWORKS 
communication module 

LED is OFF continuously as soon as 
power is applied  Faulty hardware or power supply 

LED is ON continuously, even when 
power is first applied  Faulty hardware or power supply 

LED flashes when power is applied, 
goes OFF, then comes ON solid 

Indicates the communication module does not have the 
application image (APB/NXE) and interface (XIF) files 
properly installed - reload application files, which can be 
found on www.daikinapplied.com or www.lonmark.org 

LED flashes briefly once every second   

The communication module could be experiencing an error 
with the application software or possibly the hardware - 
reload application files, which can be found on 
www.daikinapplied.com or www.lonmark.org 

LED steadily blinks ON and OFF at ½ 
Hz Rate (1 Sec = ON; 1 Sec = OFF) 

Normal operation if the communication module is 
decommissioned 
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Q: Service Pin LED does not light when pressed 
A: The communication module may not be installed properly, the hardware may be 
faulty, or the LED itself may be faulty. 

• Remove the communication module and then re-install it, making sure the 
connector snaps into place on all four of the pins.  Use caution as it is easy to 
either miss just one pin or all of the pins, even with the standoffs. 

• Verify if the BAS recognizes the Neuron ID even if the LED is not lit. 
• If the communication module is properly installed but no Neuron ID is 

broadcast, remove the communication module and install it on a different unit.  
If the LED does not function correctly and/or the BAS still does not recognize 
the Neuron ID, replace the communication module.   
 

Q: The BAS does not “see” some or all LONWORKS Configuration Properties  
A: The communication module uses multiple User-defined Configuration Property 
Types (UCPTs) to pass MicroTech III-specific unit information to the BAS.  If the BAS 
can access other LONWORKS variables, then it is likely that the BAS is not allowing 
access to these user-defined configuration properties. 

• The controls integrator should contact his/her technical support to determine 
how to allow the BAS to access configuration properties. 

• The complete set of LONWORKS files required for BAS integration are 
available on www.daikinapplied.com or www.echelon.com should it be 
necessary to reinstall them. 
 

Factory-installed LONWORKS communication modules are loaded with all application 
files required for network integration. 
 

Flasher 
The following section summarizes common issues with Flasher tools and the 
corresponding solutions.   

Q: The main screen does not populate with the proper Flasher information    
A: See Figure 55. This may indicate a problem with the connection between Flasher 
and the computer  

 Verify that the Flasher tool has power and that the Flasher serial cable is 
connected to the computer.  

 Additionally, check that the communications port selected in the 
‘Communications’ section of the ‘Options’ menu is set to the correct port (i.e. 
the port to which the Flasher tool is connected). 
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Figure 55. Main Screen does not Populate 

  

Q: The Flasher tool’s LED is red 
A: Disconnect and remove power from Flasher.  After a few seconds, reapply power 
to Flasher.  Connect it to the unit controller again, verifying that the triangle on the 10-
pin connector of Flasher is properly installed on the keyed connector on the unit 
controller’s 10-pin JTAG port (see Figure 32). 

Q: After applying power, the Target VCC field changes to a value that is too low 
A: See Figure 56. This could indicate a communication error between Flasher and 
the unit controller. Verify that the Flasher 10-pin connector is properly connected to 
the keyed 10-pin JTAG connector port on the unit controller.  Also verify that the unit 
controller is connected and powered properly.  See Figure 7. 

Figure 56. Incorrect Target VCC Value 

  

Q: After preparing the file to be downloaded, the Range and/or Target VCC 
fields appear in red 
A: If the screen shown in Figure 57 appears, this indicates that the device has not 
been properly selected. Repeat Step 9 from the Flasher downloading procedure. 
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Figure 57.  Incorrect Range and Target VCC Fields 

    

Q: After selecting Download and Verify, a “Busy does not react” error message 
appears   
A: If the message shown in Figure 58 appears verify that the Flasher 5 hardware is 
properly connected to the unit controller.  Apply power and perform the download 
again. 

 Figure 58. Download Error Message   

 

Q: After selecting Download and Verify, a “supply voltage too low” error 
message appears  
A: If the message shown in Figure 59 appears, verify that the power supply is 
properly connected to the Flasher tool and that the power supply is plugged in to the 
power source. 

Figure 59. Download Error Message   

 

Q: After selecting Download and Verify, an “ID mismatch” error message 
appears  
A: If the message shown in Figure 60 appears, perform the following steps: 

1. Verify that the passcode has been set correctly in Step 17 on page 10. 

2. Remove power from the unit controller. 

3. Apply power to the unit controller. 

4. Repeat the Flasher download procedure. 
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Note: Replace the unit controller if this problem persists after repeating the programming 
process. 

Figure 60. Download Error Message   

 
 

J-Link/J-Flash ARM  
The following section summarizes common issues with J-Link tools and the 
corresponding solutions.   

Q: “Failed to connect” error message appears 
A: If the message shown in Figure 61 appears, follow these steps: 

1. Verify that the unit controller has power.  
2. Select Auto from the J-Flash Target tab. 

Figure 61. Failed to Connect Error Message 

  
3. Click Yes if the message shown in Figure 62 appears. 

 

Figure 62.  Relocate Message 

 
 
4. If the message shown in Figure 63 appears, the BACnet communication 

module flash memory must be manually erased by continuing to Step 5 below.  
If this message does not appear, proceed to the Download BACnet 
Communication Module Firmware section. 
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Figure 63.  Locked Program Error Message 

 

 
5. Remove the jumper from pin 4 and pin 5 on J2 of the BACnet communication 

module, if connected.  See Figure 64. 
6. With power applied to the unit controller, connect the jumper between pin 5 

and pin 6 on J2 of the BACnet communication module as shown in Figure 64. 
 

Figure 64.  Manual Erase Jumpers 

 
 
7. Remove power from the unit controller. 
8. Remove the jumper from pin 5 and 6 on J2 of the BACnet communication 

module, replacing the jumper on pin 4 and pin 5 of the BACnet communication 
module, if previously connected. 

9. Apply power to the unit controller.  The flash memory has now been 
completely erased, so all configured settings return to default values. 

10. Proceed to the Download BACnet Communication Module Firmware section. 
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Daikin Applied Training and Development
Now that you have made an investment in modern, efficient Daikin equipment, its care should be a high 
priority. For training information on all Daikin HVAC products, please visit us at www.DaikinApplied.com 
and click on Training, or call 540-248-9646 and ask for the Training Department.

Warranty

All Daikin equipment is sold pursuant to its standard terms and conditions of sale, including Limited 
Product Warranty. Consult your local Daikin Applied representative for warranty details. To find your 
local Daikin Applied representative, go to www.DaikinApplied.com.

Aftermarket Services

To find your local parts office, visit www.DaikinApplied.com or call 800-37PARTS (800-377-2787).  
To find your local service office, visit www.DaikinApplied.com or call 800-432-1342.

This document contains the most current product information as of this printing. For the most up-to-date 
product information, please go to www.DaikinApplied.com.

Products manufactured in an ISO Certified Facility.
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